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Bonjour tout le monde, 
J'entame ici un colossal tuto (82 screenshots ) et donc le but est de vous expliquer 
comment faire un bête petit jeu avec Blender. Le jeu ne sera bien évidemment pas excellent, 
mais c'est pour vous montrer la base (et plus même ) de la création du jeu. Vous pourrez 
par la suite vous améliorer car après ce tutoriel, vous aurez déjà de sérieuses bases avec 
Blender  
Voilà l'aperçu 
A la fin de ce tutoriel vous serez capable d'arriver par vous même à: 

 
 

Sources 
 
Sans le savoir, ce tutoriel m'ayant été expliqué par un ami, quelqu'un m'a fait découvrir que le 
tuto était à la base dans un magazine anglais destiné à l'apprentissage de Blender. Je n'ai 
malheureusement pas le nom de ce magazine, si quelqu'un a une idée, je marquerai ici. 

Table des matières: 
 
 
Pourquoi ce tutoriel? 
________ 
Apprentissage rapide de Blender 
1) Le smooth 
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2) Le subsurf 
3) L'extrusion 
--Les raccourcis 
________ 
Création de la voiture 
--la forme 
--Les pneus 
--La/les couleurs 
--Couleur de pneus 
--Améliorations visuelles de la voiture  
--Enrégistrement de la voiture 
_______ 
Création du circuit!  
_______ 
Créer les commandes 
_______ 
Améliorations possibles 
 
Niveau: J'ai fait de mon mieux pour que ce tutoriel soit accessible à un large public. Je pense 
qu'à la fin de ce tutorial, les débutants pourront dire qu'il sont intermédiaire  

Pourquoi ce tutorial? 
 
 
 
Alors tout d'abord, je tiens à vous dire que le résultat n'est pas exceptionnel et que vous n'allez 
pas (en tout cas pas tout de suite) vendre un jeu à 50€ dans tous les magasins grâce à ce 
tutoriel. Ici, nous allons apprendre un peu plus que la base de la création de jeu. 
 
Moi, ici, je propose de faire un jeu qui n'en est pas un car il n'a pas de but. Mais vous saurez 
faire bouger la voiture dans un environnement en 3D. Ce tutorial a été fait en essayant d'etre 
le PLUS COMPLET POSSIBLE et rien a été baclé. Vous pourrez donc, normalement, tous le 
faire. 
 
J'insiste aussi pour dire que c'est ici Blender 2.44 qui a été utilisée. 
Apprentissage rapide de Blender 
 
 
 
Il est possible qu'il y ait des différences entre mes images et les vôtres, je dois parfois déplacer 
des colonnes pour les captures. 
 
Blender est un magnifique programme qui permet des choses incroyables. Beaucoup 
d'architectes s'en servent, c'est tout dire. Avec Blender vous pourrez modéliser des bâtiments, 
des voitures, des villes, des visages. Blender est un programme libre créé en Hollande. Il est, 
c'est vrai, repoussant car il n'est pas super beau, ce programme, et en plus il est en anglais (on 
sait le traduire, mais vaut mieux avoir tout en anglais pour suivre les tutoriaux du net). 
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En outre, avec ce logiciel gratuit, vous pourrez créer des jeux! C'est donc ce que nous allons 
faire dans ce tutorial. 

1) Le Smooth 
 
 
 
Le Smooth est une méthode qui change la lumière sur l'objet. Enfin, ne vous préoccupez pas 
trop de ces effets, mais comme il y a plusieurs bouton
même à ce que l'on parle du même pour mon tutorial 

 

2) Le SubSurf 
 
 
Le SubSurf est une méthode qui rends les formes carrées un peu plus rondes. Cette méthode 
ressemble au Smooth mais n'utilise pas la lumière.

3) L'extrusion 
 
 
L'extrusion sert à allonger un point, une face ou une arrête. Cest très utile car pour notre 
voiture par exemple, nous créons d'abord sa forme en deux dimensions et grâce à l'extrusion 
nous lui donnons les 3 dimensions 
 
Raccourcis: 
 
Vous trouverez tous les raccourcis claviers utilisés dans Blender sur ce site
 
Et c'est parti pour le tuto 
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gratuit, vous pourrez créer des jeux! C'est donc ce que nous allons 

Le Smooth est une méthode qui change la lumière sur l'objet. Enfin, ne vous préoccupez pas 
trop de ces effets, mais comme il y a plusieurs boutons "Smooth" dans Blender, je tiens quand 
même à ce que l'on parle du même pour mon tutorial  

Le SubSurf est une méthode qui rends les formes carrées un peu plus rondes. Cette méthode 
ressemble au Smooth mais n'utilise pas la lumière. 

L'extrusion sert à allonger un point, une face ou une arrête. Cest très utile car pour notre 
voiture par exemple, nous créons d'abord sa forme en deux dimensions et grâce à l'extrusion 
nous lui donnons les 3 dimensions  

trouverez tous les raccourcis claviers utilisés dans Blender sur ce site
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gratuit, vous pourrez créer des jeux! C'est donc ce que nous allons 

Le Smooth est une méthode qui change la lumière sur l'objet. Enfin, ne vous préoccupez pas 
s "Smooth" dans Blender, je tiens quand 

 

Le SubSurf est une méthode qui rends les formes carrées un peu plus rondes. Cette méthode 

L'extrusion sert à allonger un point, une face ou une arrête. Cest très utile car pour notre 
voiture par exemple, nous créons d'abord sa forme en deux dimensions et grâce à l'extrusion 

trouverez tous les raccourcis claviers utilisés dans Blender sur ce site 
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Création de la voiture 
 

La forme 
 
 
Ouvrez Blender. Effacez le cube qui apparaît (X) 

 
 
 
Prenez cette image de base, qui nous servira à recopier quelque chose qui ressemblera à une 
voiture: 

 
 
 
View => Background Image 
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Load =>Choisissez l'image de la voiture rouge  

 
 
 
Barre d'espace => Add => Mesh => Plane (Plan en français) 
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Après avoir vérifié que vous êtes en mode Edition, effacez 3 vertices, afin de ne laisser qu'un 
seul point. Je vous rappelle que Effacer=>X 

 
 
 
Faites le contour de la voiture avec des points. Je vous explique: 
Vous avez donc un point, un seul point, placez le sur un coutour de la carrosserie. Ensuite, 
appuyez sur Ctrl+Clic gauche et placez ce deuxieme point toujours sur le contour de la 
carrosserie mais de manière à ce que le lien entre les deux suive le contour du dessin qu'il y a 
derrière. Faites toute la carrosserie de cette manière (pas les pneus). Ensuite, Sélécionnez 
deux ou trois points et faites-en une face en appuyant sur F 
Essayez d'arriver plus ou moins à ceci: 
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Placez vous en vue du dessus maintenant ([i]View => Top ou NumPad 7) 

 
 
 
Maintenant en vue du dessus, vous voyez les points qui forment une ligne. Sélectionnez tous 
les points (Touche A) 
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Nous allons faire une extrusion. Une extrusion permet d'allonger en quelque sorte les faces 
que nous avions tantot. Vous pouvez faire ue extrusion en appuyant sur la touche "E" et en 
sélectionnant "Region". 
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Effectuez en deux, d'extrusions. Une fois, vous appuyez sur "E"=>Regions et vous allez un 
peu vers la droite, puis vous refaites la manoeuvre, encore vers la droite et vous obtenez ce 
que j'ai obtenu ci-dessous: 



���������	
��	�
�������
��	��	�	�����������	�	
����
�������
�����	

�

 
 
 
Appuyez sur "A" pour désélectionner tout les points. Appuyez sur "B" pour faire une 
sélection à l'aide d'un rectangle des points se trouvant à l'extrémité droite de votre écran 
(gauche de la voiture!!!) 
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Vérifiez que vous etes encore et toujours en Edit Mode et allez dans "Mesh Tools" et 
sélectionnez Smooth, plusieurs fois. Cela va rendre le coté de votre voiture plus lisse, plus 
normal, moins carré. 
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Personnellement, chez moi, ca donne cela: 
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Ensuite, désélectionné tout (Touche A) et sélectionnez toute la carrosserie (Touche A encore 
une fois donc.). 
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Placez le tout à droite de l'axe Y, qui est vert. C'est très important pour la suite, car nous 
allons faire une sorte de "miroir". L'avant de la voiture etant en bas de l'écran, il faut que le 
coté droit du coté gauche (oulah difficile XD) de la voiture soit tout pile sur l'axe des Y ou 
même peut etre un peu plus loin  
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Je vous l'accorde, c'est assez difficile, mais Blender n'est pas facile à expliquer, si vous ne 
vous y retrouvez pas, écrivez en bas de ce topic toutes vos questions  
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En bas à droite de la fenêtre de Blender, vous avec un bouton "Add Modifier". Cliquez dessus 
et ensuite cliquez sur Mirror. 

 
 
"Z" et "Do Clipping" doivent être cochés. Vous pouvez déjà cliquer sur "Apply" mais moi je 
l'ai fait par la suite donc vous pouvez faire comme moi 

 
 
En mode Objet et vue par dessus (
problème XD) 
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En bas à droite de la fenêtre de Blender, vous avec un bouton "Add Modifier". Cliquez dessus 

 

"Z" et "Do Clipping" doivent être cochés. Vous pouvez déjà cliquer sur "Apply" mais moi je 
l'ai fait par la suite donc vous pouvez faire comme moi  

 

mode Objet et vue par dessus (NumPad 7), vous devriez avoir ceci: (sinon il y a un 

�����������	 �	

En bas à droite de la fenêtre de Blender, vous avec un bouton "Add Modifier". Cliquez dessus 

"Z" et "Do Clipping" doivent être cochés. Vous pouvez déjà cliquer sur "Apply" mais moi je 

), vous devriez avoir ceci: (sinon il y a un 
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En vue de coté (NumPad 3) et en Edition Mode, vous avez ceci: 
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En vue de coté, toujours, et en Object Mode, vous avez ceci: 

 
 

Les pneus 
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Cliquez sur la deuxième petite case pour ouvrir un nouveau calque dans lequel on créera notre 
roue. 

 
 
 
Placez le curseur 3D au milieu de la roue du dessin: 

 
 
 
Barre d'espace => Add => Cylinder 

 
 
 
Suivez les indications suivantes: 
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Suivez les deux dessins suivants: 
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Ensuite, pour enlever l'épaisseur du pneu, sélectionnez la moitié et faites la glisser avec la 
flèche rouge vers votre droite comme ceci:

 
 
Le reste se passe de commentaires, ceux ci étant sur les images 
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Ensuite, pour enlever l'épaisseur du pneu, sélectionnez la moitié et faites la glisser avec la 
flèche rouge vers votre droite comme ceci: 

 

Le reste se passe de commentaires, ceux ci étant sur les images  
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Ensuite, pour enlever l'épaisseur du pneu, sélectionnez la moitié et faites la glisser avec la 
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La/les couleurs 
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Choisissez une couleur (j'ai choisi le rouge, comme vous pouvez le voir ci-dessous) et 
appuyez ensuite sur "Set VertColor" 
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Je vous propose de choisir une couleur un peu plus sombre et de l'appliquer avec le pinceau 
pour que la voiture ne soit pas totalement rougeVoir screenshots ci dessous: 
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Couleur de pneus 
 
 
Les trois suivantes se passent elles aussi de commentaires: 
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Améliorations visuelles de la voiture  
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Enrégistrement de la voiture 
 
 
Files => Save As => cequevousvoulez.blend 
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Save AS au dessus à droite pour sauvegarder: 

 
 

Création du circuit! 
 
 
Allez au calque numéro deux et effacez-en son arrière plan qui commence à gêner: 
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Spacebar => Add => Mesh => Grid 

 
 
Laissez les valeurs par défaut ou mettez plus grand pour un plus grand circuit. Je vous 
conseille de commencer avec la résolution par défaut. Vous aurez tout le temps de faire des 

magnifiques circuits quand vous connaitres Blender par coeur! XD 
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Allez en mode édition pour faire notre "piste": 

 
 
 
Sélectionnez des carrés, ils représentent pour le moment le circuit. Je vous conseille de 
commencer avec une forme simple car à partir de cette étape et jusqu'à la fin du tuto, ca va 

etre difficile  
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Placez vous en vue de face (NumPad 1) et bien sur en vision orthonormée (View=> 
Orthographic... (Numpad 5)) et faites une extrusion en appuyant sur "E". 
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Comme dans l'image ci dessous, je vous conseille d'extruder vers le bas  

 
 
 
No comment: 
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Rappel: Sélectionner: Clic droit || Sélectionner plusieurs points: Maj + Clic droit || grosse 
sélection: B || sélection avec une sorte de pinceau: deux fois "B" 
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Créer les commandes 
 
 
Sélectionnez votre auto; allez dans la fenêtre de logique (F4). 
Activez le bouton "Actor" pour en faire apparaître d'autres 
Activez Dynamique 
Je vous conseille de suivre le screenshot en dessous des explications 
Activez "Bounds" (Collision) et choisissez "Box" dans le menu et cliquez ensuite sur 
Compound 
Dès que vous aurez activé le type de collision, retournez aux boutons "Actor" et cherchez 
celui indiquant "radius", activez le pour envelopper votre auto. Vous ne le voulez ni trop petit 
ni trop gros . Passez en mode solide ou fil de fer pour voir la taille du rayon attribué à votre 
modèle mais cette étape n'est pas extrêmement importante à comprendre, tant que vous suivez 
le prochain screenshot . 
Maintenant, je vais vous montrer comment créer les contrôles de base puis vous pourrez 
améliorer le tout en analysant un peu le programme et ma manière de faire grâce au .blend 
joint. 
Vous voyez trois ensembles de boîtes à la droite de la scène (sensors, contrôleurs et actuators) 
Activez la boite "Add" près de la première (sensor) 
Cliquez sur la boite indiquant "Always" et dans le menu déroulant, sélectionnez "Keyboard" 
pour indiquer au moteur du jeu que le jeu se jouera avec le clavier. 
Appuyez sur la boite à côté de "Key", il 'affichera 'Press a key' et appuyez sur la flèche haut 
du clavier. Vous vous en doutez surement, je suis en train de décider de la touche qui va 
permettre à notre voiture d'avancer. 
Activez la boîte "Add" près de la seconde (controller) 
Activez la boîte "Add" près de la troisième (Actuator) 
Dans le connecteur central de "Dloc", eje propose que vous mettiez 0.30. 
Près du connecteur Sensor cliquez sur la petite balle et glissez-la vers le connecteur Controller 
puis de celui-ci vers le connecteur Actuator. 
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Cliquez pour agrandir: 
http://stocks.monsitegratuit.com/tutori ... 100/80.jpg 
 
Files => Save As => cequevousvoulez.blend 

 
 
Save AS au dessus à droite pour sauvegarder: 

 
 
 
 
Pour Jouer à votre jeu, appuyez sur la touche "P" 
 
 
Voilà, j'espère vous avoir aider. J'améliorerai le tutoriel encore et encore afin qu'il soit parfait 
pour les tous débutants, mais les gens qui ont déjà touché à Blender peuvent vraiment déjà 
réussir très bien ce tutoriel, mais pour ceux qui n'ont jamais entendu parler de Blender, je 
compte ecrire des explications sur le smooth, l'extrusion, le subsurf, etc. 
 
Bonne chance à tous, et voila le .blend de ma création que vous pouvez télécharger. J'ai 
changé un peu la couleur du paysage et ai fait des sortes de collines plus hautes que dans le 
tutoriel. 
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Pour ceux qui ne veulent pas télécharger le .blend, sachez qu'à la fin de ce tutoriel, vous êtes 
capable de faire: 

 
 

Améliorations possibles: 
 
 
Voici quelques suggestions pour améliorer votre jeu : 
1. Ajouter du son 
2. Bruit du moteur sur appui de la 
touche flèche haut. 
3. Les roues qui tournent sur appui de 
flèche droite/gauche 
4. Bruit d'impact lorsque l'auto touche le 
sol 
5. Ajouter des objets mouvants (ex. : vaches, cochons) 
6. Ajouter des tremplins et obstacles avec des flaques 
7. Ajouter des objets qui tombent et à éviter 
8. Ajouter des bâtiments et/ou des ponts 
9 . Ajouter des lacs dans les vallées 
10. Ajouter quelques arbres basse résolution 
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11. Entourer la piste avec de l'eau pour en faire une île . 
12. Ajouter un ciel 
13. ...�


